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Preface

Preface

Manual Conventions
When you are instructed to “touch” something, use your finger to touch an item on 
the screen. Small arrows (>) appear in the text. They indicate that you should touch 
a series of items on the nüvi screen. For example, if you see “touch Where to > My 
Locations,” you should touch the Where to button, and then touch the My Locations 
button. 

Contact Garmin
Contact Garmin if you have any questions while using your nüvi. In the USA, contact 
Garmin Product Support by phone: 913/397.8200 or 800/800.1020, Monday–Friday, 
8 AM–5 PM Central Time; or go to www.garmin.com/BMW. In Europe, contact 
Garmin (Europe) Ltd. at +44 (0) 870.8501241 (outside the UK) or 0808 2380000 
(within the UK).

myGarmin™ 
Go to http://my.garmin.com to access the latest services for your Garmin products. 
From the myGarmin Web site, you can do the following:
●	 Register your Garmin unit.
●	 Subscribe to online services.
●	 Unlock optional maps.
Return to myGarmin often for new Garmin product services. 

www.garmin.com/BMW
http://my.garmin.com
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Tips and Shortcuts

Tips and Shortcuts
●	 To quickly return to the Menu page, touch and hold Back.
●	 To jump from any page back to the media player when you are listening to music 

or an audio book, quickly press the  Power button twice. 
●	 To extend the battery life, close the GPS antenna when you are not using the nüvi 

for navigation. You can also decrease the screen brightness.
●	 To access the Quick Settings page, quickly press and release the  Power button. 

You can also touch  on the Menu page.
○	 To adjust the volume or brightness, move the sliders.
○	 To prevent accidental screen taps, touch Lock. To unlock the screen, press the 

 Power button. 
●	 To learn more about the nüvi Bluetooth® technology or Travel Kit features, touch 

the Help button on the appropriate screen. 

About Google Earth™ 
Go to http://earth.google.com to download the Google Earth application. With Google 
Earth installed on your computer, you can view your nüvi waypoints (Favorites) and 
track log. Connect the nüvi to your computer using the USB cable (see page 34). 
Open Google Earth. From the File menu, select Open, and browse for your *.GPX file 
(for example, F:\Garmin\gpx\Current.gpx).

http://earth.google.com
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Getting Started

Getting Started
What Is in the Box?
●	 Carrying case to protect your nüvi from scratches and accidental screen taps.
●	 AC charger to receive power from a wall outlet.
●	 USB cable to connect the nüvi to your computer. 
●	 Yellow sheet that contains your unit’s serial number, registration number for 

registering on Garmin’s Web site, and unlock code for future reference.
●	 Quick reference guide and owner’s manual.

Microphone

GPS antenna

SD card slot

Mini-USB connector

 Power button

Headphone jack
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Getting Started

Mounting the nüvi
1.	 Flip up the GPS antenna. 
2.	 Fit the bottom of your nüvi into the 

cradle.
3.	 Tilt the nüvi back until it snaps into 

place.

To remove your nüvi from the cradle
1.	 Press the small tab on the bottom of the cradle 

up.
2.	 Tilt the nüvi forward. 
3.	 Snap the protective cover on to the cradle when 

it is not in use. 

Cover

Tab
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Basic Operation

Basic Operation
Turning the nüvi On or Off
Press and hold the  Power button on the top of the nüvi. 

Charging the nüvi
●	 Connect the nüvi to the mount and start your vehicle.
●	 Connect the USB cable to the nüvi and your computer.
●	 Connect the AC adapter to the nüvi and a wall outlet. 

Acquiring Satellites
Before the nüvi can find your current location and navigate a 
route, you must do the following:

1.	 Go outdoors to an open area, away from tall buildings 
and trees.

2.	 Flip up the GPS antenna.
3.	 Turn on the nüvi. Acquiring satellite signals can take 

 a few minutes. 

The  bars indicate satellite strength. When the bars are green, the nüvi has 
acquired satellite signals; now you can select a destination and navigate to it. To use 
the nüvi indoors, close the GPS antenna. 
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Basic Operation

Volume, Brightness, and Screen Lock
1.	 Press and quickly release the  Power button, or on the Menu page, touch 

. 
2.	 Move the sliders to adjust the volume and brightness. To prevent accidental 

screen taps, touch Lock. To unlock the screen, press the  Power button. 

Resetting Your nüvi
If the nüvi screen stops functioning, turn the nüvi off and on again. If this does not 
help, do the following:

1.	 Disconnect the nüvi from external power.
2.	 Flip up the GPS antenna.    
3.	 Press the Reset button.
4.	 Connect the nüvi to a power source. The nüvi 

should automatically turn back on and operate 
normally.

Clearing User Information
	 Caution: This procedure deletes all information that you have entered.

1.	 Hold your finger on the upper-right corner of the nüvi’s screen while you turn 
on the nüvi. Keep your finger pressed until a message appears. 

2.	 Touch Yes. All factory settings are restored. Your recent selections and audio 
bookmarks are also deleted. 

➌

➋
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Basic Operation

Garmin Lock™ 
Garmin Lock is an anti-theft feature. You can turn on this feature and set a four-digit 
PIN (personal identification number) and a security location. Then each time you 
turn on the nüvi, you must enter the PIN or drive to your security location. Select any 
location, such as your home or office, for your security location. Write down your 
PIN, and keep it in a safe place. If you forget your PIN, you can go to your security 
location to unlock the nüvi. To help prevent theft of the nüvi, apply the Garmin Lock 
sticker to the inside of a vehicle window.
To lock your nüvi:

1.	 Flip up the GPS antenna.
2.	 On the Menu page, touch  > System.
3.	 Touch the button next to Garmin Lock. Touch OK.
4.	 Enter a four-digit PIN. Touch Yes to accept the PIN.
5.	 Touch OK. Drive to a security location, and touch Set.
6.	 Each time you turn on the nüvi, you must enter the four-digit PIN or drive to the 

security location (with the antenna up).

	 Note: If you forget your PIN and your security location, you must send your nüvi 
to Garmin to get it unlocked. You must also send a valid product registration or 
proof of purchase.
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Main Pages

Main Pages

Menu Page
GPS satellite 
signal status Settings

Quick settings

Phone

Traffic

Battery status

Menu Page

●	 GPS satellite signals—represents the satellite signals being received by your nüvi. 
When you see green bars, you have a strong signal. 

●	 Battery status—represents the status of the battery charge. The lightning bolt 
symbol indicates that the nüvi is currently charging.

●	 Settings—accesses the nüvi settings.
●	 Quick settings—accesses the settings for volume, brightness, and screen lock.
●	 Phone—appears when you pair the nüvi with a phone; accesses phone features.
●	 Traffic—appears when you connect an FM traffic receiver; accesses the traffic 

incident list.
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Main Pages

Map Page 
From the Menu page, touch  View Map to open the Map page. The  
vehicle icon shows your current location. 

Map Page while Navigating a Route

Touch to open the Trip 
Information page. 

Touch the text bar to 
preview the turns in 
the route.

Touch to zoom out.

Touch to zoom in.

Touch to return to the 
Menu page.

Touch to open the Next 
Turn page. 

Trip Information Page
To open the Trip Information page, touch Speed or Arrival on the Map page. The 
Trip Information page displays your current speed and provides helpful statistics 
about your trip. 

Current direction 
 of travel

Distance traveled 
(odometer)

Trip Information Page

Distance to your 
final destination
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Main Pages

Resetting Trip Information
Touch Reset Trip to reset the Trip Information page before beginning a trip. If you 
make frequent stops, leave the nüvi turned on so it can accurately measure elapsed 
time during the trip. Touch Reset Max to reset the maximum speed.

Turns Preview Page
Touch the green text bar on the top of the Map page to open the Turns Preview page. 
This page displays all turns in the route and the distance between turns. Touch  or 

 to scroll through the list of turns. Touch a turn on the list to view the Next Turn 
page for that turn. Touch Map to view the entire route on the map. 

Turns Preview Page

Direction of  
the turn

Distance to  
the turn
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Main Pages

Next ���������� Turn Page
To view an upcoming turn on the map, touch Turn In on the Map page, or touch any 
turn from the Current Route page. The Next Turn page displays the upcoming turn on 
the map and the distance and time remaining before you reach the turn. Touch  
or  to view other turns in the route. When you are finished viewing the Next Turn 
page, touch Back.

Upcoming turn

Next Turn Page

Distance to the upcoming turn

Approximate time left until 
this turn
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Where to 
Finding Your Destination

1.	 Flip up the antenna on the nüvi to get satellite signals.
2.	 On the Menu page, touch  Where to.
3.	 Search for your destination. 
4.	 Touch Go.

Following Your Route
Follow the route to your destination using the Map page. As you travel, the nüvi 
guides you to your destination with voice prompts and text directions at the top of the 
Map page. If you depart from the original route, the nüvi recalculates the route and 
provides new route instructions. 
●	 The vehicle icon  shows your location.
●	 Your route is marked with a purple line.
●	 Follow the arrows as you take turns.
●	 A checkered flag marks your destination.

	 Tip: To narrow your search results list, touch Spell and enter the name or part of 
the name. 
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Where To

Finding a BMW Center
1.	 Touch Where to > BMW Centers. The nüvi finds the 

BMW centers closest to you current location. 
2.	 Select a BMW center, and save it to your Favorites 

(see page 15 for more information). 

Finding an Address
1.	 Touch Where to >  Address. 
2.	 Select a country (if necessary), state, and city. If you are not sure of the city, 

select Search All.
3.	 Type the address number, and touch Done. 
4.	 Type the street name until a list of streets appears.
5.	 Select the street. If more than one matching address is found, select the one 

that you want.
6.	 Touch Go.

	 Tip: You can search for a postal code. Enter the postal code instead of the city 
name. (Not all map data provides postal code searching.)

	 NOTE: Finding an intersection is very similar to finding an address. Touch 
Intersection, and enter the two street names. 
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Where To

Finding a Place by Spelling the Name 
1.	 Touch Where to >  Spell Name.
2.	 Using the on-screen keyboard, enter letters contained in the name. Touch 

 to enter numbers. Touch  to delete the last character entered; 
touch and hold  to delete the entire entry. 

3.	 Touch Done.
4.	 Select the place you want to visit.
5.	 Touch Go.

Finding a Place Using Coordinates
You can find a place by entering the location coordinates. This can be helpful if you 
enjoy geocaching.

1.	 Touch Where to >  Coordinates.
2.	 Enter the coordinates for your destination, and touch Next.
3.	 Touch Go.

Finding a Place ����������� Using the Map
Touch Where to >  Browse Map. 
●	 Touch the map and drag to view different parts of the map. 
●	 Touch  and  to zoom in and out. 
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Where To

●	 Touch anywhere on the map. An arrow points to the location. 
○	 Touch Go to navigate to the selected location. 
○	 Touch Save to save this location to your Favorites. 
○	 If the antenna is closed, touch Set Loc. to set the location. 

To view places on the map: 
After you search for a place, touch Show Map. You can drag the map, and zoom in or 
out, as necessary. Touch Back when you are finished. 

Expanding Your Search
1.	 Touch Where to > Near.
2.	 Select an option:

●	 Where I Am Now—searches for places near your current location. 
●	 A Different City—searches for places near the city you enter. 
●	 My Current Route—searches for places along the route you are currently 

navigating.
●	 My Destination—searches for places near your current route destination.

3.	 Touch OK.

	 Note: Your nüvi automatically searches for places near your current location. 
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Where To

Adding a Stop
You can add one stop (via point) to your route. The nüvi gives you directions to the stop 
and then to your final destination. 

1.	 When navigating a route, touch Where to.
2.	 Search for a location.
3.	 Touch Go. 
4.	 Touch Yes if you want to stop at this via point before your final destination, or 

touch No if you want this new location to become your new final destination.

Adding ���a Detour
If you want the nüvi to try to calculate a new route to avoid something ahead of you, 
use the following procedure. 

1.	 On the Map page, touch Menu to return to the Menu page.
2.	 Select Detour. If possible, the nüvi creates a new route.

The nüvi attempts to get you back on your original route, as soon as possible. If 
the route you are currently taking is the only reasonable option, the nüvi might not 
calculate a detour. 

Stopping Your Route
If you want to stop your current route, return to the Menu page and touch Stop. 
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My Locations

My Locations

You can save your favorite places in  My Locations. 

Saving Places
1.	 After you search for a place you want to save, touch Save. 
2.	 Touch OK. The place is saved in Where to > My Locations > Favorites. 

Finding Saved Places
1.	 Where to > My Locations > Favorites. 
2.	 Select a place.
3.	 Touch Go.

Saving Your Current Location
1.	 Touch Where to > My Locations > My Current Location.
2.	 Touch Save, enter a name, and touch Done. The place is saved in My 

Locations > Favorites.
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My Locations

Setting a Home Location
You can set a home location for the place you return to most often. Your home 
location is saved in Favorites. 

1.	 Touch Where to > My Locations > Set Home.
2.	 Select an option, and follow the on-screen instructions. 

Going Home
After you set your home location, you can route to it at any time. Touch Where to > 
My Locations > Go Home.

Editing Saved Places
You can change the name, symbol, or phone number of a saved place. 

1.	 Touch Where to > My Locations > Favorites. 
2.	 Select the place you want to edit.
3.	 Touch Edit.
4.	 Touch the appropriate option, and make the changes.

Deleting Saved Places
1.	 Touch Where to > My Locations > Favorites. 
2.	 Select the place you want to delete.
3.	 Touch Edit > Delete > Yes. 
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Travel Kit

Travel Kit 
The  Travel Kit provides many features that are helpful when you are traveling. 

1.	 On the Menu page, touch Travel Kit. 
2.	 Touch the item you want to open. 

Touch Help to learn more about the nüvi Travel Kit. To purchase a Travel Kit 
accessory, go to http://shop.garmin.com. You can also contact your Garmin dealer to 
purchase nüvi accessories.

MP3 Player
This feature involves managing files on your nüvi (see pages 33–36).

1.	 Touch Travel Kit >  MP3 Player > Browse.
2.	 Select a category. 
3.	 To play the entire category from the beginning of the list, touch Play All. To 

play starting with a specific song, touch the title. 
Touch  to adjust the volume. 

Tap  to go to the beginning of the song; touch and hold to rewind the song. 

Tap  to skip to the next song; touch and hold to fast forward the song. 

Touch  to pause the song. 

Touch  to repeat. Touch  to shuffle. 

http://shop.garmin.com
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Travel Kit

When you are listening to music or an audio book, quickly press the  Power button 
twice to jump from any page back to the player page. Touch Back to return to the 
previous page you were viewing (such as the map). 

	 Note: The nüvi plays MP3 files only. It does not support iTunes® M4A/M4P files. 

Playlists
This feature involves managing files on your nüvi (see pages 33–36).

1.	 Using your computer and an audio program such as Winamp™, create a 
playlist of MP3 files. 

2.	 Save the playlist as an M3U file. 

	 NOTE: You may need to edit the M3U file with a text editor, such as Notepad, 
to remove the path (location) to the MP3. The M3U file should only list the MP3 
files in your playlist, not their location. Refer to the audio program’s Help file for 
instructions.

3.	 Transfer the playlist and the associated MP3 files to the “nuvi” or “nuvi SD” 
drive. The M3U file must be in the same location as the MP3 files.

4.	 On the nüvi, touch Travel Kit > MP3 Player > Browse > Import Playlist. All 
available playlists appear.

5.	 Touch a playlist to start playing the MP3 files. You cannot change the order of 
the playlist from your nüvi.
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Travel Kit

Audible Book Player
Your nüvi provides sample  Audible books, which are only portions of the book. 
Purchase full books from Audible.com at www.garmin.audible.com. 

1.	 Touch Travel Kit > Audible Book Player.
2.	 Touch Browse.
3.	 Touch a category, and then touch a book title.

Touch  to adjust the volume. 

Tap  to jump back. Tap  to skip ahead. Touch and hold to move more quickly. 

Touch  to pause the book. 

Touch the book cover art to view book information. 

When you are listening to music or an Audible book, quickly press the  Power 
button twice to jump from any page back to the player page. Touch Back to return to 
the previous page you were viewing (such as the Map page). 

Using Bookmarks
To create a bookmark, touch  and Bookmark. To view your bookmarks, 
touch  and then touch a bookmark. Touch Play to listen to the book from the 
bookmark. 

www.garmin.audible.com
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Travel Kit

Loading Audible Books to Your nüvi
This feature involves managing files on your nüvi (see pages 33–36). 

1.	 Create an Audible.com account at http://garmin.audible.com.
2.	 Purchase a book.
3.	 Download AudibleManager to your computer.
4.	 Activate your nüvi. The first time you open AudibleManager, you are led 

through the activation process. This is a one-time process.
5.	 Connect the nüvi to your computer.
6.	 Download the book to your computer.
7.	 Open AudibleManager and use it to transfer the book to your nüvi or nüvi SD 

card drive.

	 TIP: Refer to AudibleManager’s Help file for detailed instructions. Select Help 
from the menu, and click Help. 
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Travel Kit

Picture Viewer
You can view pictures that you have stored in your nüvi using the  Picture Viewer. 
This feature involves managing files on your nüvi (see pages 33–36).

1.	 Touch Travel Kit > Picture Viewer.
2.	 Touch a picture to view a larger image of it.

	 Tip: Touch Rotate to rotate the image 90°. 

Viewing a Slide Show
Touch Slide Show to display each image for a few seconds and then display the 
next image. During the slide show, touch the screen at any time to stop and see more 
options. You can zoom in or out and pan by dragging the picture with your finger. 

World Clock 
1.	 Touch Travel Kit >  World Clock.
2.	 To change a city listed, touch the city. 
3.	 Select a new time zone (or city). Touch OK when done. 
4.	 Touch World Map to view a map.
5.	 Nighttime hours are shown in the shaded area. Touch World Clock to view the 

clocks again, or touch Back to exit.
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Travel Kit

Currency Converter�
1.	 Touch Travel Kit >  Currency Converter. 
2.	 Touch a currency button to change the currency.
3.	 Select a currency, and touch OK. 
4.	 Touch the blank rectangle under the currency rate you want to convert.
5.	 Enter the number. Touch Done. 
6.	 Touch Clear to convert a different value.

Updating Conversion Rates
The nüvi allows you to update the currency conversion rates manually so that you are 
always using the most current rates. 

1.	 Touch Travel Kit > Currency Converter. 
2.	 Touch Update.
3.	 Touch the rate you want to update. 
4.	 Touch  to erase the current rate. Enter a new rate, and touch Done. 
5.	 Touch Save to finish. 

	 Tip: Touch Restore to use the original conversion rate. Touch and hold  to erase 
the entire entry.
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Travel Kit

Measurement Converter 
1.	 Touch Travel Kit >  Measurement Converter. 
2.	 Select a type of measurement, and touch OK.
3.	 Touch a unit of measure that you want to change. 
4.	 Select a unit of measure, and touch OK. Repeat, if necessary.
5.	 Touch the blank rectangle to enter a value. 
6	 Enter a value, and touch Done.
7.	 Touch Clear to enter another measurement.

Calculator
1.	 Touch Travel Kit >  Calculator.
2.	 Enter the first number of your calculation.
3.	 Touch an operator (÷, x, -, or +).
4.	 Enter the second number of your calculation.
5.	 Touch =.

6.	 Touch  to make a new calculation.
Touch . to add a decimal.
Touch ± to make the number negative or positive.
Touch % to make the number a percent (0.01).
Touch  to clear the entry.
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Using Bluetooth Technology

Using Bluetooth Technology
If you have a phone with Bluetooth wireless technology, and your phone is supported 
by the nüvi (see www.garmin.com/bluetooth), you can use your nüvi as a hands-
free device. Hands-free phone features on the nüvi are only available if your phone 
supports that feature using Bluetooth technology (for example, phone book, voice 
dial, and call waiting). You can speak into the microphone on the front of the nüvi, 
and listen to the conversation over the nüvi speaker. To use this hands-free feature, 
you must pair (connect) your phone with the nüvi. You can initiate this pairing from 
the phone settings or from the nüvi settings. Refer to your phone’s documentation for 
more information. 

Pairing Your Phone
To enable or disable the Bluetooth technology:

	 Note: The default Bluetooth setting is Disabled.

1.	 On the Menu page, touch  > Bluetooth. 
2.	 Set the Bluetooth field to Enabled. The  Bluetooth icon appears on the 

Menu page if the nüvi is enabled. To disconnect the nüvi from your phone or to 
prevent a phone from automatically pairing, touch Disabled.

	 Note: Confirm that your phone is supported by the nüvi (See www.garmin.com/
bluetooth.).

www.garmin.com/bluetooth
www.garmin.com/bluetooth
www.garmin.com/bluetooth
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To pair using the phone settings:
1.	 Access the phone’s settings menu.
2.	 Access the phone’s Bluetooth technology settings. Sometimes these are in a 

Bluetooth, Connections, or Hands-free menu.
3.	 Search for devices. The nüvi must be 10 meters or closer and turned on.
4.	 Select the nüvi from the list of devices.
5.	 Enter the nüvi PIN code (or passkey), 1234, on your phone.

To pair using the nüvi settings:
1.	 Touch  > Bluetooth. 
2.	 Ensure that the Bluetooth button is set to Enabled.
3.	 Touch Add. 
4.	 Set your phone to Find Me/Discoverable mode, and touch OK on the nüvi. 

Select your phone on the list. Enter the nüvi PIN code (or passkey), 1234, on 
your phone.  

If the pairing is successful, the  Phone icon appears on the nüvi Menu page. After 
the initial pairing, the two devices can connect automatically each time you turn them 
on. Touch Help to learn more about the nüvi Bluetooth features.
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Hands-Free Features
Calling a Number

1.	 Touch  Phone >  Dial. 
2.	 Enter the number, and touch Dial. 
3.	 To end the call, touch , and then touch End Call.

Using Touch Tones
If you need to enter information using a keypad during the call (for example, entering 
a password for your voice mail), do the following:

1	 During the call, touch  > Call Options > Touch Tones. 
2.	 Enter the information. Touch Back twice when finished.
3.	 To end the call, touch End Call.

Calling a Place
1.	 Touch  Phone >  POI Dial. 
2.	 Search for the place that you want to call.
3.	 Touch Dial.
4.	 To end the call, touch , and then touch End Call.

	 Note: You can also call a place that you find using the Where to menu.
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Receiving a Call
1.	 Ensure that your phone is paired with the nüvi.
2.	 When you receive a call, a message appears on the nüvi. Touch Answer. 
3.	 To end the call, touch , and then touch End Call.

Call Waiting
If you get a call waiting call, the Incoming Call message appears. Touch Answer. The 
first call is placed on hold. 

1.	 During the call, touch  > Switch To. 
2.	 Touch End Call to hang up; this does not disconnect the call on hold. 

Transferring Audio to Your Phone
This feature can be helpful if you want to leave the vehicle without disconnecting 
your call.

1.	 During the call, touch  > Call Options > Transfer Audio to Phone. 
2.	 Continue your call using your mobile phone.

Phone Book
The phone book feature is only available if your phone supports phone book transfer. 
After pairing, it can take a few minutes for the phone book to be available. Touch  
> Phone Book.
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Call History
Touch  > Call History to access information about the phone numbers that you last 
dialed, last received calls from, and those calls that you missed.

Calling Home
1.	 Touch  > Call Home to set up or change your home information. The first 

time that you use this function, follow the on-screen instructions to enter your 
home information, and then touch Save. 

2.	 Enter your phone number, and touch Done. 

To change your home phone number:
1.	 Touch Where to >  My Locations > Favorites. 
2.	 Touch Home.
3.	 Touch Edit.
4.	 Touch Change Phone Number.

Voice Dial
To use the voice dial function of the nüvi, your phone must support voice dial and 
must be set up properly to take voice commands. Touch  > Voice Dial. 

Phone Status
To access information about the phone signal, battery status, and carrier name of your 
phone service, touch  > Status.
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Sending SMS/Text Messages
If your phone supports SMS/text messaging, you can send and receive text messages 
on the nüvi. After pairing, it can take a few minutes for text messages to be available. 
Touch  > Text Message. 
●	 To view your messages, touch Inbox, Outbox, or Drafts; and touch a message. 

You can reply to or forward a text message.
●	 To create a new text message, touch Compose.

	 Note: Messages sent from your nüvi do not appear in your phone’s outbox.

Dropping a Connection
1.	 Touch  > Bluetooth > Change. 
2.	 Touch the device name that you want to drop, and then touch Drop. 
3.	 To confirm, touch Yes. The dropped phone can be reconnected later.

Removing a Phone from the List
1.	 Touch  > Bluetooth > Change. 
2.	 Touch the device name that you want to remove, and then touch Delete. 
3.	 To confirm, touch Yes. If you want to use hands-free functions with this 

removed phone again, you must pair this phone and the nüvi again.
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Using FM Traffic
If you are using an optional traffic receiver, you can view traffic information on your 
nüvi. When a traffic message is received, your nüvi displays the incident on the map, 
and you can change your route to avoid the traffic incident. For traffic data coverage 
areas, go to www.garmin.com/fmtraffic. The FM traffic receiver and nüvi must be in 
data range of an FM station transmitting traffic data to receive traffic information.

	 Note: Garmin is not responsible for the accuracy of the traffic information. The 
FM traffic receiver simply receives signals from the traffic service provider and 
displays that information on your nüvi. 

Connecting the FM Traffic Receiver
	 Note: You can only access the traffic information if the nüvi is connected to an 

FM traffic receiver. 

1.	 Place your nüvi into the mount. 
2.	 Plug the mini-USB cable from the FM traffic receiver  

into the USB connector on the side of the nüvi.

www.garmin.com/fmtraffic
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Viewing Traffic Incidents
1.	 On the Menu page, touch  to display a list of traffic incidents.
2.	 Select an item to view details.
3.	 Select an option.

Avoiding Traffic
The Map page displays  or  in the lower-right corner of the screen when there is 
a traffic incident on your current route or road. 

1.	 Touch  or .
2.	 Select an item to view details.
3.	 Touch Avoid.

Traffic Symbols
North 

American Meaning International

Road Condition
Road 

Construction
Congestion

Accident

Incident

Information
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Severity Color Code
The bars to the left of the traffic symbols indicate the traffic incident’s severity:

 Green = �Low severity; traffic is flowing normally.
 Yellow = �Medium severity; traffic is a bit congested.
 Red = �High severity; traffic is heavily congested or stopped. 

Purchasing an Additional Traffic Subscription�
To renew or add traffic subscriptions, go to www.garmin.com/fmtraffic. 

	 Note: You do not need to activate the subscription included with your FM traffic 
receiver (if it came with one). The subscription activates automatically after your 
nüvi acquires satellite signals while receiving traffic signals from the pay service 
provider. 

1.	 Touch  > Traffic > Add. 
2.	 Write down the FM traffic receiver’s unit ID. Go to www.garmin.com/fmtraffic to 

purchase a subscription and get a code.
3.	 After you receive the 25-character code, touch Next on the nüvi, and enter the 

code. 
4.	 Touch Done. 

You must obtain a new code each time you renew your service. If you own multiple 
FM traffic receivers, you must obtain a new code for each receiver.

www.garmin.com/fmtraffic
www.garmin.com/fmtraffic
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Managing Files on Your nüvi
You can store files (such as JPEG images and MP3 music files) in the nüvi’s internal 
memory or on an optional SD card. 

	 NOTE: The nüvi is not compatible with Windows® 95, Windows 98, Windows NT, 
or Windows Me. This is a common limitation of most USB Mass Storage devices. 

Supported File Types
●	 MP3 music files
●	 M3U playlists
●	 JPG image files
●	 AA audio book files
●	 GPI custom POI files from Garmin’s POI Loader
●	 GPX waypoint files from MapSource
●	 Maps from MapSource

	 Note: The nüvi does not support iTunes® M4A/M4P files. 
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Loading Items to Your nüvi
Step 1: Insert an SD Card (Optional)
To insert the card, press it in until it clicks. 

Connecting the Mini-USB CableInserting an SD Card

Step 2: Connect the ���������� USB Cable
1.	 Plug the small end of the USB cable into the Mini-USB connector on the side 

of the nüvi. 
2.	 Connect the larger end of the USB cable to an available USB port on your 

computer.
After you connect your nüvi to your computer, one or two additional drives appear in 
your computer’s list of drives: “nuvi” and “nuvi sd.” “nuvi” is the available storage in 
the nüvi’s internal memory. “nuvi sd” appears if an SD card is inserted into the nüvi.

	 Note: On some operating systems, the nüvi drives may not be named 
automatically. See your Help file to learn how to rename the drives. 
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Step 3: Transfer Files to the nüvi 
For Windows:

1.	 Connect the nüvi to your computer. 
2.	 Browse your computer for the file you want to copy. 
3.	 Highlight the file and select Edit > Copy. 
4.	 Open the “nuvi” or “nuvi sd” drive.
5.	 Select Edit > Paste. The file then appears in the list of files on the nüvi 

memory or SD card. 

For Mac® computers:
1.	 Connect the nüvi to your computer. Your drive should mount onto your desktop 

as two mounted volumes (drives): the “nuvi” and “nuvi sd” volumes.
2.	 To copy files to your nuvi or SD card, drag and drop any file or folder onto the 

volume icon. Double-click the volume to open it. To help manage the files, add 
folders (press the Command + Shift + N keys). 

Step 4: Disconnect
For Windows:

1.	 When you are finished transferring files, double-click the Unplug or Eject  
icon in your system tray. 

2.	 Select “USB Mass Storage Device,” and click Stop. 
3.	 Select the nüvi drives, and click OK. You can disconnect your nüvi from your 

computer now. 
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For Mac computers:
1.	 When you are finished transferring files, drag the volume icon to the Trash  

(it turns into an Eject  icon) to unmount the device. 
2.	 Disconnect your nüvi from your computer now.

More Information about Your ������������ nüvi Drives
For files that you manually load onto your nüvi, like your MP3 or JPEG files, you can 
paste them anywhere in the “nuvi” and “nuvi sd” drives. If another program, such as 
POI Loader, places a file in a specific folder, keep that file in that specific folder.

Deleting Files from the nüvi
You can delete files from your nüvi just as you would delete files from your computer. 
Select the file that you want to delete from your nüvi, and press the Delete key on 
your computer’s keyboard. 

	 Caution: If you are not sure about a file’s purpose, do NOT delete it. Your nüvi 
memory contains important system files that should NOT be deleted. Be especially 
cautious of files located in folders entitled “Garmin.”
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Customizing the nüvi

Restoring Settings
To restore all settings you have changed, touch  > Restore. To restore settings for 
an individual category, touch Restore on that particular page. 

Map Settings
To change the map settings, touch  > Map. 

Map Detail—adjust the amount of detail shown on the map. Displaying more detail 
causes the map to redraw more slowly. 

Map View—change the perspective of the Map page. 
●	 Track Up—display the map in two dimensions (2D) with your direction of 

travel at the top.
● 	 North Up—display the map in 2D with North at the top.
●	 3D View—display the map in three dimensions (3D), Track Up orientation. 

This is the default map view.
Vehicle—choose a vehicle icon for your map. The default is . For more 
vehicles, go to www.garmin.com/vehicles.

Map Outlines—turn on this setting if you loaded supplemental maps onto your nüvi 
and you want to view outlines of that area.

Map Info—view the maps loaded on your nüvi and their versions. 

www.garmin.com/vehicles
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System Settings
To change the system settings, touch  > System. 

WAAS/EGNOS—turning on WAAS/EGNOS might improve GPS accuracy, but it 
consumes more battery power. For information about WAAS/EGNOS, go to  
www.garmin.com/aboutGPS/waas.html.

Safe Mode—turn on or off the Safe Mode feature. The default Safe Mode setting is 
On. When your vehicle is moving, Safe Mode disables all unit functions that require 
significant operator attention and could become a distraction while driving. 

Garmin Lock—turn on Garmin Lock™ to lock your nüvi. For more information, see 
page 5. 

Touch Tones—disable or enable the tone that sounds each time you touch the screen.

About—display your nüvi’s software version number, unit ID number, and audio 
version number. You need this information to update the system software or purchase 
additional map data.

www.garmin.com/aboutGPS/waas.html
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Locale Settings
To change the locale settings, touch  > Locale. 

View the location settings, such as language. Touch the setting that you want to 
change, or touch Change All to adjust the settings based on a selected country. On 
each screen, touch the setting you want, and then touch OK. 

Text Language—change all on-screen text to the selected language. Changing the 
Text Language does not change the language of map data, such as street names and 
places or user-entered data. 

Voice Language—change the language for all voice prompts and messages. Your 
nüvi might contain two different types of voice languages: text-to-speech (TTS) and 
pre-recorded. 

Languages noted with a person’s name are TTS voices: for example, American 
English-Jill. The TTS voices “read” and “speak” the same words that appear 
on the nüvi. The voices have an extensive vocabulary, and they pronounce the 
street names as you approach turns. 

The pre-recorded voices have a limited vocabulary and do not speak names of 
locations or streets. 

Time Format—choose a 12-hour, 24-hour, or UTC time format.

Units—change units of measure to kilometers (Metric) or miles (Statute). 
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Display Settings
To change the display settings, touch  > Display. 

Color Mode—touch Daytime for a light background, Nighttime for a black 
background, or Auto to automatically switch between the two. 

Backlight Timeout—select the length of time the backlight stays on after external 
power is removed. Reducing the time the backlight stays on increases the battery life. 

Touch Screen—recalibrates (or realigns) the touch screen to respond properly. Touch 
Recalibrate and then follow the directions. 

Screenshot—enables you to take a picture of the screen when you quickly press and 
release the  Power button. The pictures are saved in your “nuvi” drive. 

	 Note: When Screenshot is On, the Quick Settings screen does not open when you 
press the  Power button. 

Navigation Settings
To change the navigation settings, touch  > Navigation. 

Route Preference—select a preference for calculating your route.

Vehicle—specify your vehicle type to optimize routes. 



BMW Owner’s manual for nüvi 360	41

Customizing the nüvi

Avoidances—touch Enabled to access the road types. Select the road types you want 
to avoid on your routes. The nüvi uses these road types only if alternative routes take 
you too far out of your way or if no other roads are available. If you have an FM 
traffic receiver, you can also avoid traffic incidents.

Attention Tone—turn on or off the attention tone.

Voice Prompts—select when you want the nüvi to announce route navigation and 
system status. 

Bluetooth Settings
To change the Bluetooth settings, touch  > Bluetooth. 

Connections—select or add a Bluetooth device. For more information, see  
pages 24-29. 

	 Note: The nüvi’s PIN code (or passkey) is 1234.

	 Drop—disconnect the nüvi from your phone. 
	 Delete—remove a device from the device list. Touch the device, and then touch 

Delete.
Bluetooth—enable and disable the Bluetooth component. 
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Friendly Name—enter a friendly name that identifies your nüvi on devices with 
Bluetooth technology. Touch Done after you have entered the name. 

Help—read helpful topics about nüvi Bluetooth features.

Restore—restore the original Bluetooth settings. Restoring the Bluetooth settings 
does not clear the pairing information. 

Traffic Settings
To change the traffic settings, touch  > Traffic. 

Proximity Points Settings
This option is visible only if you have loaded custom POIs databases or TourGuide 
files onto your nüvi. To change the proximity points settings, touch  > Proximity 
Points. 

Alerts—touch Change to turn on or off the alerts when you approach custom POIs. 
Touch Audio to set the type of audio notification that you want to hear, and touch OK. 

TourGuide—set how you want the audio for Garmin TourGuide™ to be activated.
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U������������������  pdating the nüvi Software
Use WebUpdater to update your nüvi software. Go to www.garmin.com/products/
webupdater to download the WebUpdater program. After downloading WebUpdater to 
your computer, connect your nüvi to your computer, run WebUpdater, and follow the 
on-screen instructions. WebUpdater automatically downloads the update and installs it 
on your nüvi. 

You can also download software updates from www.garmin.com/BMW. Click 
Updates and Downloads. Follow the on-screen instructions.

Register your nüvi to receive notification of software and map updates. To register 
your nüvi, go to http://my.garmin.com. 

Purchasing and Loading ������������Additional MapSource Maps
To find out the version of the maps that are loaded on your nüvi, open the Menu page. 
Touch  > Map > Map Info. To unlock additional maps, you need your unit ID and 
serial number. 

Check www.garmin.com/unlock/update.jsp to see if an update for your map software 
is available. You can also purchase additional MapSource map data from Garmin and 
load the maps on your nüvi’s internal memory or on an optional SD card. 

www.garmin.com/products/webupdater
www.garmin.com/products/webupdater
www.garmin.com/BMW
http://my.garmin.com
www.garmin.com/unlock/update.jsp


44	 BMW Owner’s manual for nüvi 360

Appendix

Refer to the MapSource Help file for more information about using MapSource and 
loading maps and waypoints on your nüvi. The waypoints you create in MapSource 
appear in My Locations > Favorites. 

Optional Accessories
For more information about accessories, go to http://shop.garmin.com. You can also 
contact your Garmin dealer to purchase accessories.
●	 FM traffic receiver
●	 External remote antenna
●	 Travel Kit accessories

Custom ��������������������������   POIs (Points of Interest)
Your nüvi accepts custom POI databases, available from various companies on the 
Internet. Some custom POI databases contain alert information for points such as 
school zones. Your nüvi can notify you with a proximity alarm when you approach 
one of these points.

After downloading your POI database, use the Garmin POI Loader to install the POIs 
into your nüvi. The POI Loader is available at www.garmin.com/poiloader. Using the 
POI Loader program, you can store the custom POIs on your “nuvi” drive or your SD 
card. Refer to the POI Loader Help file for more information. 

http://shop.garmin.com
www.garmin.com/poiloader
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To view your custom POIs, touch My Locations > Custom POIs.  
To change the settings for your Custom POIs, touch  > Proximity Points. 
To delete the custom POIs and Favorites from your nüvi, touch Where To > My 
Locations > Delete All. Touch Yes to delete all of your Favorites and your custom 
POIs. 

	 Caution: Garmin is not responsible for the consequences of using a custom POI 
database or the accuracy of the safety camera or other custom POI database. 

About the Garmin Travel Guide™

The Garmin Travel Guide is an optional accessory. Much like a paper travel guide, the 
Garmin Travel Guide provides detailed information about places, such as restaurants 
and hotels. To purchase the Travel Guide accessory, go to www.garmin.com/extras. 

To use the Travel Guide:
1.	 Insert the SD card into your nüvi. 
2.	 On the Menu page, touch Travel Kit > Travel Guide.
3.	 Touch the guide that you want to use.
4.	 Touch a category. Touch a sub-category, if necessary.
5.	 Touch a location in the list.
6.	 Do one of the following: 

Touch Go to go to the location. 
Touch Map to display this item on a map. 

www.garmin.com/extras


46	 BMW Owner’s manual for nüvi 360

Appendix

Touch Save to save this location in your Favorites. 
Touch More to view more information about the location. 

About SaversGuide®

The SaversGuide is an optional accessory that is available only in North America.
With the SaversGuide preprogrammed SD data card and membership card, your nüvi 
is a digital coupon book that notifies you of merchants near your current location 
where you are eligible for a discount, such as restaurants, hotels, movie theaters, and 
auto repair shops.

About the Garmin Language Guide
The Garmin Language Guide is an optional accessory. The Language Guide puts data 
from Oxford’s multilingual resources and five bilingual dictionaries in the palm of 
your hand. A sample version of the Garmin Language Guide is provided. 

Loading the Garmin Language Guide
When you receive the Garmin Language Guide SD card, you must load the data on 
the nüvi. Follow the directions on the package or in the nüvi Help file. 

All dictionary, word, and phrase content is © Oxford University Press. Voice files are 
© Scansoft.
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Translating Words and Phrases
1.	 Touch Travel Kit > Language Guide > Words and Phrases > Language.
2.	 Select the From and To languages and touch Back.
3.	 Select a category.
4.	 Search for a phrase, and touch it.
5.	 Touch  to hear the translation. 

Words and Phrases Tips
●	 Use Search for Keyword in Phrases to find all phrases that contain a specific 

word. 
●	 Touch Search to spell the word. 
●	 Touch an underlined word to replace the word. 
●	 Touch More Variations to change words in the phrase or to get a different 

translation.
●	 If you cannot find what you are looking for in Words and Phrases, look in the 

Bilingual Dictionaries. 
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Using the Bilingual Dictionaries
The Garmin Language Guide provides five bilingual dictionaries. You can easily 
translate words and hear their pronunciation using the bilingual dictionaries. 

1.	 Touch Travel Kit > Language Guide > Bilingual Dictionaries.
2.	 Touch a translation option. If necessary, touch To English.
3.	 Search for the word and touch it.
4.	 Touch  to hear the word spoken.

Bilingual Tips
●	 Touch Search to spell the word or the beginning of the word. 
●	 Touch Legend to view the legend for the selected language. The legend contains 

information on abbreviations, labels, and pronunciation symbols used in each 
dictionary.

About Garmin TourGuide
The Garmin TourGuide allows your nüvi to play third-party, GPS-guided audio tours. 
These audio tours, for example, can take you on a route while playing interesting facts 
about historical sites along the way. As you travel, the audio information is triggered 
by GPS signals. 

If you have loaded TourGuide files on your nüvi, touch Where to > My Locations > 
Custom POIs. To change the settings for your Custom POIs, touch  > Proximity 
Points.
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About GPS Satellite Signals
Your nüvi must acquire GPS (Global Positioning System) satellite signals to operate. 
If you are indoors, near tall buildings or trees, or in a parking garage, the nüvi might 
not acquire satellites. Go outside to an area free from tall obstructions to use your 
nüvi. Close the antenna to turn off the GPS and use it indoors. 

When the nüvi acquires satellite signals, the signal strength bars on the Menu page 
are green . When it loses satellite signals, the bars turn red or hollow . 
Touch the signals strength bars in the upper-left corner of the Menu page to view GPS 
information. Touch anywhere on the screen to return to the Menu page. 

Speed

Satellite signal 
strength bars

Sky view

Elevation
Direction of 

travel

GPS status

Current position

The sky view shows the satellites from which you are receiving. The satellite signal 
strength bars indicate the strength of each satellite you are receiving. 

For more information about GPS, go to www.garmin.com/aboutGPS.

www.garmin.com/aboutGPS
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Caring for Your nüvi 
Your nüvi contains sensitive electronic components that can be permanently damaged 
if exposed to excessive shock or vibration. To minimize the risk of damage to your 
nüvi, avoid dropping your nüvi or operating it in high shock/vibration environments.

Cleaning the nüvi
The nüvi is constructed of high quality materials and does not require user 
maintenance other than cleaning. Clean the nüvi’s outer casing (not the touch screen) 
using a cloth dampened with a mild detergent solution and then wipe dry. Avoid 
chemical cleaners and solvents that can damage plastic components.

Caring for the Touch Screen
Clean the touch screen with a soft, clean, lint-free cloth. Use water, isopropyl alcohol, 
or eyeglass cleaner. Apply the liquid to the cloth and then gently wipe the touch 
screen. 
●	 The touch screen is intended for finger operation. 
●	 Although a PDA stylus may also be used to operate the touch screen, never attempt 

this while operating a vehicle. 
●	 Never use a hard or sharp object to operate the touch screen or damage may result. 
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Protecting Your nüvi
●	 Do not store the nüvi where prolonged exposure to extreme temperatures can occur 

(such as in the windshield), as permanent damage may result. 
●	 Do not expose the nüvi to water. Contact with water can cause the nüvi to 

malfunction.
●	 Though a PDA stylus can also be used to operate the touch screen, never attempt 

this while operating a vehicle. Never use a hard or sharp object to operate the touch 
screen, because it can damage the screen.

●	 Keep the nüvi in the leather carrying case when not in use.

Avoiding Theft
●	 Remove the nüvi and mount from sight when not in use. 
●	 Use the Garmin Lock feature (see page 5). 
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Battery Information 
Your nüvi contains an internal (non-removable) lithium-ion battery. Contact your local 
waste disposal department for information on properly disposing of the nüvi.  
See page 56 for battery warnings. 

Battery Tips
●	 Your nüvi’s battery should last 4 to 8 hours depending on usage. 
●	 To extend the battery life, reduce the time the backlight stays on. Touch  > 

Display > Backlight Timeout.
●	 Close the antenna when you do not need to receive GPS signals. 
●	 Do not leave your nüvi in direct sunlight, and avoid prolonged exposure to 

excessive heat. 

Battery Gauge
The battery icon in the upper-right corner of the Menu page indicates the status of the 
internal battery. Periodically, you might notice that the battery gauge is not completely 
accurate. To increase the accuracy of the battery gauge, fully discharge the battery and 
then fully charge it without interrupting the charging. For best results, do not unplug 
the nüvi until it is totally charged. 

Battery charging or connected to external power
Full battery
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Troubleshooting
Problem/Question Solution/Answer

My nüvi never gets satellite 
signals.

Take your nüvi outside, away from tall buildings and 
trees. Stop your vehicle.

My battery gauge does not 
seem accurate.

Allow the nüvi to fully discharge and then fully charge it 
(without interrupting the charge cycle).

The touch screen is not 
responding to my taps properly.

Calibrate the screen. Touch  > Display. Touch 
the Recalibrate button, and follow the on-screen 
instructions. 

My phone will not connect to 
the nüvi. 

Check your Bluetooth settings. Touch  > Bluetooth 
> Enabled. Make sure your phone is turned on and 
is less than 10 meters (about 33 feet) away from your 
nüvi. See www.garmin.com/bluetooth for more help.

How do I know my nüvi is in 
USB Mass Storage Mode?

When your nüvi is in USB Mass Storage Mode, a 
picture of a nüvi connected to a computer is shown. 
Also, you should see a new drive on your computer 
desktop.

My computer never senses that 
the nüvi is connected.

1.	Unplug the USB cable from your computer. 
2.	Turn the nüvi off and then back on again. 
3.	Plug the USB cable into your computer. The nüvi 

automatically goes into USB Mass Storage Mode. 
The nüvi cannot communicate with Windows 95, 
Windows 98, Windows NT, or Windows Me.

www.garmin.com/bluetooth
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A message appears saying 
“Unsafe Removal of Device” 
when I unplug the USB cable.

To disconnect your nüvi from your computer, double-
click the Unplug or Eject  icon in your system tray. 
Select “USB Mass Storage Device,” and click Stop. 
Select the nüvi drives, and click OK. Disconnect your 
nüvi from your computer. 

How do I map my nüvi ����������� drives in 
Windows?

1.	Turn off your nüvi. 
2.	Plug the USB cable into the nüvi and your computer. 

Your nüvi automatically turns on. 
3.	On your computer, click Start > Settings > Control 

Panel > Administrative Tools > Computer 
Management > Storage > Disk Management. 

4.	Click a nüvi removable disk drive (either the internal 
memory or your SD card drive). Right-click your 
mouse and select Change Drive Letter and Path.

5.	Select Change, select a drive letter from the list, and 
click OK. 
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Specifications
Size: 3.87” W x 2.91” H x 0.87” D  
(9.8 x 7.4 x 2.2 cm)

Weight: 5.1 oz (144.6 g)

Display: 3.5” (8.9 cm) diagonal, 2.8” 
W x 2.1” H (7.1 x 5.3 cm); 320 x 240 
pixels; QVGA TFT landscape display 
with white backlight and anti-glare touch 
screen.
Case: Not waterproof or IPXO

Temperature range: 32°F to 140°F  
(0°C to 60°C)
Data storage: Internal memory and 
optional removable SD card. Data is 
stored indefinitely.

PC interface: USB mass storage,  
plug-and-play

Power input: vehicle power cable 

Usage: 15 W max. @ 13.8 VDC

Battery life: 4 to 8 hours depending on 
usage

Headphone jack: Standard 3.5 mm 

GPS Performance
Receiver: WAAS enabled

Acquisition times*: 
Warm: < 1 second 
Cold: < 38 seconds 
Factory reset: < 45 seconds
*On average for a stationary receiver 
with a clear view of the sky

Update rate: 1/second, continuous

GPS accuracy:
Position: < 10 meters, typical
Velocity: 0.05 meter/sec RMS

GPS (WAAS) accuracy:
Position: < 5 meters, typical
Velocity: 0.05 meter/sec RMS
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Important Safety and Product Information
 Warnings

Battery Warnings
If these guidelines are not followed, the internal lithium-
ion battery may experience a shortened life span or may 
present a risk of damage to the GPS unit, fire, chemical 
burn, electrolyte leak, and/or injury.
•	 Contact your local waste disposal department to 

properly dispose of the unit/battery.
•	 Do not leave the unit exposed to a heat source or in 

a high temperature location, such as in the sun in an 
unattended vehicle on a hot day. To prevent damage, 
remove the unit from the vehicle or store it out of 
direct sunlight, such as in the glove box. 

•	 Do not incinerate. 
•	 When storing the unit for a limited length of time, 

store within the following temperature range:  
-4° to 140°F (-20° to 60°C). When storing the unit 

for an extended time, store within the following 
temperature range: 32° to 77°F (0° to 25°C). 

•	 Do not operate the unit outside of the following 
temperature range: -4° to 131°F (-20° to 55°C).

If this unit contains a non-user-replaceable, rechargeable 
lithium-ion battery, do not remove or attempt to remove 
the battery.
Warning: This product, its packaging, and its 
components contain chemicals known to the State of 
California to cause cancer, birth defects, or reproductive 
harm. This notice is provided in accordance with 
California’s Proposition 65. See  
www.garmin.com/prop65 for more information.

Failure to avoid the following potentially hazardous 
situations could result in an accident or collision 
resulting in death or serious injury.
•	 When navigating, carefully compare information 

displayed on the unit to all available navigation 
sources, including information from street signs, 
visual sightings, and maps. For safety, always resolve 
any discrepancies or questions before continuing 
navigation and defer to posted road signs.

•	 Always operate the vehicle in a safe manner. Do not 
become distracted by the unit while driving, and 
always be fully aware of all driving conditions. 

Minimize the amount of time spent viewing the unit’s 
screen while driving and use voice prompts when 
possible. Do not input destinations, change settings, 
or access any functions requiring prolonged use of the 
unit’s controls while driving. Pull over in a safe and 
legal manner before attempting such operations.

•	 The unit is designed to provide route suggestions. 
It is not designed to replace the need for driver 
attentiveness regarding road closures or road 
conditions, traffic congestion, weather conditions, or 
other factors that may affect safety while driving.

www.garmin.com/prop65
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Important Information
Map Data Information: One of the goals of 
Garmin is to provide customers with the most complete 
and accurate cartography that is available to us at a 
reasonable cost. We use a combination of governmental 
and private data sources, which we identify in product 
literature and copyright messages displayed to the 
consumer. Virtually all data sources contain some 
inaccurate or incomplete data. In some countries, 
complete and accurate map information is either not 
available or is prohibitively expensive. 
The California Electronic Waste Recycling Act of 
2003 requires the recycling of certain electronics. For 
more information on the applicability to this product, see 
www.erecycle.org.

FCC Compliance
This product has been tested and found to comply with 
Part 15 of the FCC interference limits for Class B digital 
devices FOR HOME OR OFFICE USE. These limits are 
designed to provide more reasonable protection against 
harmful interference in a residential installation, and are 
more stringent than “outdoor” requirements.
Operation of this device is subject to the following 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that may 
cause undesired operation.
This equipment generates, uses, and can radiate radio 
frequency energy and may cause harmful interference 
to radio communications if not installed and used in 
accordance with the instructions. However, there is no 
guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful 

interference to radio or television reception, which can 
be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by 
one of the following measures:
•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the equipment and the 

receiver.
•	 Connect the equipment into an outlet that is on a 

different circuit from the GPS unit.
•	 Consult the dealer or an experienced radio/TV 

technician for help.
This product does not contain any user-serviceable parts. 
Repairs should only be made by an authorized Garmin 
service center. Unauthorized repairs or modifications 
could result in permanent damage to the equipment, and 
void your warranty and your authority to operate this 
device under Part 15 regulations.

Industry Canada Compliance
Category I radiocommunication devices comply with 
Industry Canada Standard RSS-210. Category II 
radiocommunication devices comply with Industry 
Canada Standard RSS-310. 

Declaration of Conformity
Hereby, Garmin declares that this nüvi 360 product is 
in compliance with the essential requirements and other 
relevant provisions of Directive 1999/5/EC. To view the 
full Declaration of Conformity, see the Garmin Web site 
for your Garmin product: www.garmin.com/BMW. Click 
Manuals, and then click Declaration of Conformity.

www.erecycle.org
www.garmin.com/BMW
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BMW of North America  
Limited Warranty
BMW of North America, LLC provides a limited 
warranty for this product against defects and 
malfunctions to the first retail purchaser when it is 
purchased through an authorized BMW center. The 
warranty period is for 2 years or the remainder of the 
vehicle warranty, whichever is greater. See an authorized 
BMW center for additional information on coverage and 
limitations. 
NOTE: The nüvi has no user-serviceable parts. For 
product services and repairs, contact your authorized 
BMW center.
NOTE: The nüvi is fastened shut with screws. Any 
attempt to open the case to change or modify the unit 
in any way voids your warranty and may result in 
permanent damage to the equipment.

Software License Agreement
BY USING THE nüvi 360, YOU AGREE TO BE 
BOUND BY THE TERMS AND CONDITIONS 
OF THE FOLLOWING SOFTWARE LICENSE 
AGREEMENT. PLEASE READ THIS AGREEMENT 
CAREFULLY.
Garmin grants you a limited license to use the software 
embedded in this device (the “Software”) in binary 
executable form in the normal operation of the product. 
Title, ownership rights, and intellectual property rights in 
and to the Software remain in Garmin.
You acknowledge that the Software is the property of 
Garmin and is protected under the United States of 
America copyright laws and international copyright 
treaties. You further acknowledge that the structure, 
organization, and code of the Software are valuable trade 
secrets of Garmin and that the Software in source code 
form remains a valuable trade secret of Garmin. You 
agree not to decompile, disassemble, modify, reverse 
assemble, reverse engineer, or reduce to human readable 
form the Software or any part thereof or create any 
derivative works based on the Software. You agree not 
to export or re-export the Software to any country in 
violation of the export control laws of the United States 
of America.
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Index
Symbols
2 dimensional  37
3 dimensional  37

A
about button  38
accessories  17, 44
acquiring satellites  3
acquisition times  55
AC charger  1
adding a stop  14
alerts  42
answering a call  27
antenna, GPS  vi
attention tone  41
audible books  19
avoiding

road types  41
theft  51
traffic  32, 41

B
backlight timeout  40
Back button  vi
bars, green satellite  3
battery

information  52
life  55
status  6

bilingual dictionaries  48
bilingual tips  48
Bluetooth technology  24–29
bookmarks  19
box contents  1
brightness  vi, 4
browsing the map  12

C
cable, USB  1
calculator  23
call

a number  26
a place  26
audio  27
history  28
home  28
waiting  27

Canada compliance  57
caring for your nüvi  50
carrying case  1
charging the nüvi  3
cleaning

the nüvi  50
clearing user information  4
composing a text message  29
computer connection  34
connecting

the FM traffic receiver  30
the USB cable  34

connections, Bluetooth  41
content, product box  1
convert

currency  22
measurements  23

converting currency  22
updating conversion  

rates  22
coordinates  12
currency  22
current location, saving  15
customizing your nüvi  37

map  37
navigation  40
system setup  38

custom POIs (points of  
interest)  44

D
data storage  55
daylight saving  39
delete

character  12
custom POIs  45
files from the nüvi  36
saved places  16
user data  4

deleting all information  4
destination, finding your  10
detour  14
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disconnecting your nüvi  35, 54
drives  34
dropping a connection  29

E
editing saved places (my  

locations)  16
EGNOS  38
enabling Bluetooth  24
ending a call  26
expanding your search  13

F
Favorites  15
FCC compliance  57
files

deleting  36
managing  33
supported types  36
transferring  35

finding places
by name  10
by postal code  11
intersection  11
item on the map  12
near another location  13
using coordinates  12

flag, checkered  10
FM traffic receiver  16, 28, 

30–32
following your route  10

G
Garmin Lock  5, 51
geocaching  12
going home  16
Google Earth  iii, vi
GPS  6, 52

accuracy  55
antenna  vi, 3
information  49
performance  55
signals, about  49

green bars  6

H
hands-free features  24–29
headphone jack  1, 55
help  17, 25
home

calling  28
going  16
location, setting  16

I
importing a playlist  18
incoming call  27
iTunes  18, 33

K
keyboard  12

L
Language Guide  46–48
legend, bilingual dictionary  48
license agreement, software  58
listening to MP3 files  17
loading additional maps  43
loading Audible books  20
lock, screen  vi, 4
locking your nüvi  5

M
M3U playlist  18
M4A/M4P  18
Macintosh  35, 36
map  13

browse  12
customize  37
info button  37
outlines  37
page  7
software version  37
update maps  43
view  37
zoom  12

MapSource  43
measurements  23
menu page  6
messaging, text  29
metric units  39
microphone  1
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mini-USB connector  1, 34
MP3  17, 18
myGarmin  iii
my locations (Favorites)  15, 

16, 28

N
narrow your results list

spell the name  10
navigation settings  40
next turn page  9
north up  37
nuvi drives  34, 35

O
on-screen keyboard  12
optional accessories  44

P
pairing your nüvi  25
passkey, pairing  25
PC interface  55
phone book  27
phone icon  6
pictures  21
PIN, Garmin Lock  5
playing Audible books  19
playlist  18
POI (point of interest)  44
postal code  11
power button  vi, 3
power input  55

present location, saving  15
preview turns  8
protecting your nüvi  51
proximity points  42
purchasing a traffic  

subscription  32

Q
quick settings  vi, 4

R
recalibrate touch screen  40
receiving a call  26
registering your nüvi  iii, 43
removing a phone from the 

list  29
removing from the cradle  2
resetting

maximum speed  8
trip information  8
your nüvi  4

restoring settings  37
routing preferences  40

S
safe mode  38
satellites, acquiring  3
satellite signals  6, 49
saved places

delete  16
edit  16

SaversGuide  46

saving places  15
saving your current location  13
school zone database  44
screenshot  40
screen lock  4
SD card  34, 55

disk drive  34, 35
security location  5
settings  37
setting a home location  16
show map  13
slide show  21
SMS  29
software version  38
specifications  55
spell the name of a place  12
status, phone  28
sticker, Garmin Lock  5
stop, adding a  14
stop navigation  14
stop USB  35
storing your nüvi  51
supported file types  33
switching between calls  27
system setup  38

T
temperature range  55
text language  39
text messaging  29
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theft prevention  51
touch screen

cleaning  50
recalibrating  40

touch tones  26
TourGuide  42, 48

playing files  48
track up  37
traffic  30

avoid  31, 41
icon  6
incidents  31
receiver, connecting a  30
settings  42
subscription  32
symbols  31

transferring audio to your 
phone  27

transferring files  35
translating words and  

phrases  47
Travel Guide  45
travel kit  17–23
trip information page  7
troubleshooting  52
turning the nüvi on or off  3
turns preview page  8

U
unit ID  38
units of measure  39
unlock code  1
unlock optional maps  iii
updating currency rate  55
updating software  43
USB connector  1, 34
user data, deleting  4

V
vehicle icon  7, 10, 37
vehicle type  40
via point  14
viewing places on the map  13
voice dial  28
voice language  39
voice mail  26
voice prompts  41
voltage  55
volume  vi, 4

W
WAAS  38, 55
warranty  58
WebUpdater  43
Where to  10
Winamp  18
words and phrases  47, 48
world clock  21

Z
zoom  12
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